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 UPOTREBA PROGRAMSKOG PAKETA 

MICROSOFT OFFICE PROJECT 2007 
U PLANIRANJU ISHRANE PRIPADNIKA 
VOJSKE SRBIJE 

Mijatović B. Radoš, Generalštab Vojske Srbije, Uprava za logistiku (J-4), 
Odsek za opštu logistiku, Beograd 

Sažetak: 

U radu je prikazan način upravljanja projektima pomoću program-
skog paketa Microsoft Office Project 2007 sa težištem na planiranju is-
hrane. Pravilnu i uspešnu – efikasnu ishranu pripadnika Vojske nije 
moguće realizovati bez primene efikasnih metoda i tehnika za podršku 
odlučivanju. Primena savremenih metoda i tehnika u planiranju i orga-
nizovanju ishrane imala bi za rezultat stvaranje ušteda na raznim polji-
ma delovanja (artikli hrane, transport, radna snaga, sredstva za rad, 
vreme, novčana sredstva i dr.). U radu je prikazan samo deo moguć-
nosti programskog paketa Microsoft Office Project 2007 koje korisnici 
mogu proširivati i nadograđivati. 

Ključne reči: Microsoft Office Project 2007, program, planiranje, upra-
vljanje, resursi, ishrana, jelovnik. 

Uvod 
oliko su procesi u organizovanju ishrane pripadnika Vojske pod 
kontrolom? Da li zaista uvek raspolažemo pravim saznanjima o 

svim stanjima u sistemu ishrane? Ako postoje problemi na tom planu mo-
guće ih je rešiti angažovanjem softvera za planiranje i praćenje procesa. 

Kako raste obim zadataka rastu i iskušenja: u dinamičnom okruženju 
svaka odluka je posledica procene uslova za poslovanje, radi uspešne 
realizacije postavljenih zadataka. Ali, prosta procena nije dovoljna: kada 
neki proces započne, pravilno upravljanje je od kritične važnosti – ne sa-
mo zbog održanja discipline poslovanja, nego i zato što je čest slučaj da 
razni faktori utiču na proces i menjaju parametre poslovanja. Može se de-
siti da se u kritičnom momentu pokvari neka od mašina ili uređaja, da ne-
ki od radnika ode na bolovanje ili da dobavljač artikala hrane „zakaže“ sa 

K 

UDC: 004.9:355.657/.658 

radosmijatovic@gmail.com
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rokom isporuke. Sve su to svakodnevna iskušenja sa ozbiljnim procen-
tom mogućnosti da se dese. Iskustvo u radu, u takvim situacijama, biće 
presudno u iznalaženju optimalnog rešenja... Ali, mora se priznati, ne 
može se precizno sagledati svaka posledica neke promene stanja u po-
slovanju, a između vrlo dobre i vrlo loše odluke više nije velika razlika. 

U navedenim situacijama svaka vrsta pomoći je 
dobrodošla. Jedna od mogućnosti svakako je angaž-
ovanje namenskog softvera čijom pravilnom upotr-
ebom se može biti makar u ravni sa iskušenjima, ako 
ne i korak ispred. To je program Microsoft Office Pr-
oject. Postoji više vrsta i modela ovog programa, ali 
je Microsoft Office Project 2007 najnovija verzija kl-
ijentskog programa, ali i kompletan sistem za upravlj-
anje projektima u preduzećima (Enterprise Project 

Management, EPM). Sistem Project 2007 čini izbor jedne od dve edicije 
klijentskog programa koji je član sistema Microsoft Office 2007, ali se isp-
oručuje nezavisno, kao i nekoliko namenskih sistema i komponenti koji se 
angažuju na strani servera ili služe za povezivanje sa njima.  

Upravljanje projektima pomoću 
microsoft office projecta 
Upravljanje projektima predstavlja skup alata i veština koje pomažu 

da se predvide i kontrolišu rezultati nastojanja preduzetih u organizaciji. 
Da bismo uspešno rukovodili projektima vrlo je važno da ih dovršimo u 
roku, da ostanu unutar granica budžeta, kao i da klijenti budu zadovoljni 
rezultatima. Rad na nekom projektu može se posmatrati na nekoliko na-
čina, a najpogodniji je trougao projekta: 

 

Vreme    Obim rada 
 Troškovi 

 
Osnovna ideja je u tome da svaki projekat poseduje određeno vre-

mensko ograničenje, određenu vrstu budžeta i da zahteva određenu koli-
činu rada kako bi bio dovršen. Da bi se efikasno upravljalo projektom po-
trebno je uskladiti ove ograničavajuće faktore. 

Microsoft Project predstavlja softverski paket za upravljanje projek-
tima u okviru Microsoft Office familije koji nudi poznata firma Microsoft 
[1, 23]. Ovaj programski paket je namenjen, pre svega, za planiranje, pra-
ćenje i kontrolu realizacije manjih i srednjih projekata, i predstavlja jedan 



 

129 

M
ija

to
vi
ć,

 R
., 

U
po

tre
ba

 p
ro

gr
am

sk
og

 p
ak

et
a 

M
ic

ro
so

ft 
O

ffi
ce

 P
ro

je
ct

 2
00

7 
u 

pl
an

ira
nj

u 
is

hr
an

e 
pr

ip
ad

ni
ka

 V
oj

sk
e 

Sr
bi

je
, s

tr.
 1

27
–1

49
 od najlakših i najviše korišćenih programskih paketa za upravljanje pro-

jektima. MS Projectom postiže se sledeće: 
– praćenje svih informacija koje se sakupe o poslu, trajanju i resursima; 
– vizualizacija i prezentiranje plana projekta u standardnim, dobro 

definisanim formatima; 
– efikasno raspoređivanje zadataka i resursa; 
– razmena informacija o projektu; 
– komunikacija sa resursima i drugim nosiocima odgovornosti uz za-

državanje potpune kontrole. 
Velika prednost koju Microsoft Project ima u odnosu na druge apli-

kacije jeste u tome što uključuje i softversku mašinu za planiranje – raču-
narski mozak koji može da obradi zahteve kao što su lančani efekti kada 
jedan zadatak iz niza od 100 zadataka promeni svoj početni datum. 

Prikazi MS Projecta 
MS Project sadrži na desetine prikaza koji se koriste da bi se unosile, 

uređivale, analizirale i prikazivale informacije o projektima. U opštem sluča-
ju prikazi su fokusirani ili na detaljne podatke o zadacima ili na detaljne po-
datke o resursima. Neki od najznačajnijih i najčešće korišćenih prikaza su: 

– Gantt Chart 
– Resource Sheet 
– Task Sheet 

– Resource Usage 
– Task Usage 
– Network Diagram 

 

Gantt Chart 
Uobičajen način za prikazivanje plana projekta, posebno kada se 

plan prezentira drugim osobama. Koristan je za unos i fino podešavanje 
detaljnih podataka o zadatku, kao i za analizu projekta. 

Prikazi liste 
– Resource Sheet – prikazuje detaljne podatke o resursima u for-

matu tabele, sa jednim resursom po redu. 
– Task Sheet – prikazuje listu detaljnih podataka o zadatku. 
Prikazi korišćenja 
–  Resource Usage – prikazuje sve zadatke koji su dodeljeni pojedi-

načnom resursu. Takođe pokazuje dodeljenu količinu rada po resursu na 
vremenskoj skali. 

– Task Usage – grupiše resurse prema zadacima kojima su dodeljeni. 
Network Diagram 
Ovaj prikaz se fokusira na relaciji između zadataka. Svako polje ili 

čvor prikazuje detaljne podatke o zadatku, a linije između polja ukazuju 
na relacije između zadataka. 
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Čuvanje i zaštita MS Projecta 
Projektni plan urađen u MS Projectu može se sačuvati kao fajlovi u 

svakoj drugoj Microsoftovoj aplikaciji, korišćenjem opcije Save As. Tako-
đe, u okviru ove opcije, MS Project omogućava svojim korisnicima da 
zaštite projekat i učine ga nedostupnim za druga lica. Čuvanje i zaštita 
MS Projecta postiže se na sledeći način: Save As →Tools →General 
Options. Otvara se okvir za dijalog Save Options. 

Ukoliko se unese šifra u polje Pr-
otection Password projekat može otv-
oriti samo osoba kojoj je poznata ta š-
ifra. Ukoliko se izabere Write reserv-
ation password, svako može otvoriti 
projekat, ali je on read-only, odnosno n-
iko ne može unositi izmene u već post-
ojeći projektni plan. Konačno, ukoliko 
se izabere opcija Read-only recomme-
nded, prilikom otvaranja projekta, MS 

Project javlja korisnicima da je preporučeno da je dokument read-only, 
odnosno da nije poželjno unositi izmene u njega. 

Postavljanje osnovnih informacija o programu 
Izgled osnovnog prozora za dijalog programa Microsoft Office Pro-

ject 2007 prikazan je na sledećoj slici: 
 

 
 
Za unošenje osnovnih informacija o projektu koristi se okvir za dija-

log Project Information (Project →Project Information): 
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Project Information omogućava unos informacija o projektu u 8 
raspoloživih polja: 

– Start Date – ako je poznato kada projekat treba da počne, izabere se 
opcija datuma početka. Kada se unesu aktivnosti projekta, program će prora-
čunati datum završetka projekta koji se bazira na utvrđenom datumu početka. 

– Finish Date – ukoliko je poznat datum do kog se mora završiti 
projekat, popunjava se ovo polje, ali pre toga se mora promeniti polje 
Schedule From. 

– Schedule From – ovo polje ima dve opcije: Project Start Date i Pro-
ject Finish Date. Izborom jedne od tih opcija određuje se način na koji će MS 
Project proračunavati datume (od datuma početka ili od datuma završetka). 

– Current Date – automatski pokazuje tekući dan. U većini slučaje-
va nema potrebe da se menja taj datum. MS Project koristi ovaj datum 
za izračunavanje različitih odstupanja od plana, osim u slučaju kada je u 
polju Status Date naveden neki datum.  

– Status Date – Ovaj datum može se izabrati kao datum preseka 
projekta, odnosno datum od kog će se pratiti napredak projekta, porediti 
planirane i ostvarene veličine, štampati izveštaji i sl. Ukoliko se ostavi 
NA, MS Project će ga posmatrati kao tekući datum. 

– Calendar – postoje tri opcije koje se mogu izabrati. 
– Priority – može se odrediti prioritet za svaki projekat ili aktivnost, 

posebno u situacijama kada više projekata deli zajedničke resurse. Prio-
ritet se definiše izborom vrednosti od 1 do 1000. 

– Enterprise Custom Fields – polje koje je neophodno ukoliko se u 
organizaciji koristi Project Server. 



 

132 

VO
JN

O
TE

H
N

IČ
K

I G
LA

S
N

IK
 2

 / 
10

 

Definisanje kalendara 
Kalendar se definiše izborom sledećih opcija: 
Tools → Options → Calendar 
Navedenim komandama dobija se okvir za dijalog prikazan na slici. 

U dobijenom okviru za dijalog može se izabrati: dan koji označava 
početak radne nedelje, mesec koji označava početak godine, početak i 
kraj radnog vremena, dnevno, nedeljno i mesečno angažovanje.  

Ukoliko se promene definisane postavke, a da bi se odnosile na ceo 
projekat, potrebno je označiti opciju Set as Default. 

Kalendar projekta je jedan od bitnih faktora pri upravljanju projek-
tom. Projekt koristi ovaj kalendar za proračun vremena potrebnog za izvr-
šenje projekta. Postoje tri podrazumevana kalendara: standardni kalen-
dar (Standard – petodnevna radna nedelja sa osmočasovnim radnim 
vremenom), kalendar treće smene (Night shift – od 11 uveče do 8 uju-
tru, svim danima osim nedelje), i 24-satni kalendar (24-hour – radno vre-
me je 24 sata, svih sedam dana u nedelji). 

Okvir za dijalog Change Working Time (Tools→Change Working 
Time) prikazuje onaj kalendar koji je izabran u okviru za dijalog Project 
Information. Dani prikazani belom bojom su podrazumevani radni dani, 
a osenčeni su neradni dani. 

Promena neradnih dana u radne i obratno, radnih u neradne, kao i 
određivanje i menjanje radnog vremena može se vršiti izborom opcije 
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 Word Weeks, a zatim na paleti details odabirom dana u nedelji i jedne 

od ponuđenih opcija:  
– Use Project default times for these days. 
– Set days to nonworking time. 
– Set day(s) to these specific working times. 
Izgled dijaloškog okvira Change Working Time prikazan je na sle-

dećoj slici: 

 

 

Na listi For calendar mogu se videti postojeći kalendari. Za kreiranje 
novog kalendara potrebno je odabrati opciju Create New Calendar... 
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Postavljanje osnovnih informacija o aktivnostima 

Da bi se promenila podešavanja vezana za tip aktivnosti, njihovo tra-
janje i sl., potrebno je koristiti: Tools →Options →Schedule. 

 
U ovom okviru za dijalog može se izabrati da li aktivnost koja se 

unosi počinje na datum početka projekta ili tekući datum: New tasks: 
Start On Project Start Date ili Start On Current Date. 

Može se izabrati jedinica u koju će biti uneti trajanje aktivnosti i rad:  
Duration is entered in: Days, Minutes, Hours, Months, Weeks, Work is 
entered in: Hours, Days, Minutes, Months, Weeks. 

U polju Default task type MS Project nudi tri opcije: Fixed Units, Fi-
xed Work i Fixed Duration. 

Pre unošenja aktivnosti bitno je izabrati tip Fixed Duration, kako bi se 
označilo da na trajanje aktivnosti neće uticati dodavanje ili oduzimanje re-
sursa. Takođe, neophodno je isključiti opciju New tasks are effort driven. 

Izrada plana dnevnih jelovnika pomoću 
programa microsoft office project 2007 
U ovom delu rada, na jednom primeru, prikazaćemo samo jednu, od 

velikog broja mogućnosti primene programskog paketa Microsoft Office 
Project 2007.  
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 Primena ovog programskog paketa u planiranju, organizovanju i rea-

lizaciji ishrane pripadnika Vojske u velikoj meri bi olakšala rad licima koja 
izvršavaju ove poslove, a pre svega neposrednim realizatorima, odnosno 
upravnicima vojnih restorana. Naime, ovim programskim paketom može 
se vršiti planiranje potreba u artiklima hrane, planiranje jelovnika, planira-
nje potrebnih namirnica za predviđena jela, angažovanje ljudstva i opre-
me, vreme angažovanja, cene koštanja, izrada izveštaja sa različitim po-
kazateljima, itd.  

Takođe, ovim programskim paketom moguće je ostvariti uvid u ste-
pen realizacije zadataka u svakom trenutku angažovanja ljudstva i ostalih 
resursa, pratiti stanje angažovanih resursa i preduzimati blagovremene 
mere za otklanjanje uočenih nedostataka. 

Prirodno, za realizaciju navedenog potrebna je odgovarajuća raču-
narska podrška, posedovanje programskog paketa Microsoft Office 
Project 2007 i poznavanje rada sa tim paketom. 

U ovom radu, kao primer, izradićemo Plan dnevnih jelovnika za se-
dam dana, izvršićemo grupisanje jelovnika po obedima i danima, odredi-
ćemo lica zadužena za pripremanje pojedinih jela, namirnice potrebne za 
pripremanje jela i cenu dnevnog angažovanja ljudstva. Uzećemo za pri-
mer sledeći jelovnik [4]: 

Obed 
Datum Doručak Ručak Večera 

29. 09. 2008. Čaj, kuvana jaja i sir 
tvrdi 

Vojnički pasulj, salata 
od svežih krastavaca 

Pljeskavica sa crnim 
lukom 

30. 09. 2008. 
Jogurt i pašteta sa 
sirom 

Čorba od krompira, 
đuveč sa mesom i slata 
od svežeg paradajza 

Pileće pečenje, pečeni 
krompir, salata od cvekle 

01. 10. 2008. Čaj, kuvane viršle i sir 
topljeni 

Supa od koncentrata, 
musaka od krompira, 
salata od svežeg 
kupusa 

Pohovana riba sa slanim 
krompirom, salata od 
kiselih paprika 

02. 10. 2008. Bela kafa, margarin i 
marmelada 

Pasulj sa suvom 
slaninom, salata od 
svežeg paradajza 

Mesni narezak i voće 
sveže 

03. 10. 2008. Jogurt i burek sa 
mesom 

Ragu čorba, grčko 
ćufte, salata od svežih 
krastavaca 

Faširana šnicla i pire od 
krompira, salata od 
svežeg kupusa 

04. 10. 2008. Bela kafa i mesni 
narezak 

Supa od koncentrata, 
pire krompir i punjene 
paprike, salata od 
cvekle 

Pita sa sirom i jogurt 

05. 10. 2008. Čaj, riblja konzerva i 
luk crni sveži 

Faširana šnicla sa 
čorbastim pasuljem, 
salata od svežeg 
kupusa 

Pekarski krompir sa 
kobasicama, salata od 
kiselih paprika 
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Nakon instaliranja programskog paketa Microsoft Offi-
ce Project 2007, on će biti pridružen osnovnom paketu Mi-
crosoft Office. Aktiviraćemo program pomoću ikonice date 
na slici pored, pri čemu će se otvoriti osnovni dijaloški okvir 
programskog paketa Microsoft Office Project 2007. Slika 
dijaloškog okvira data je u podnaslovu „Postavljanje osno-
vnih informacija“ ovog rada. Potrebno je izvršiti pripreme pr-
ograma, kako je to navedeno u prethodnim podnaslovima. 

Nakon otvaranja dijaloškog okvira i realizacije priprema, u kolonu 
Task Name unećemo nazive jela, a program će sam odrediti tadašnji da-
tum za početak i završetak aktivnosti i vreme njegovog trajanja. Ukoliko 
nam to ne odgovara možemo sami odrediti te parametre: u koloni Start 
početak primene, u koloni Finish kraj primene jela i u koloni Duration 
vreme primene. Program će sam podešavati vreme primene (kolonu Du-
ration) ukoliko mi promenimo početak ili završetak primene. Takođe, u 
desnom delu dijaloškog okvira program daje grafički prikaz planirane ak-
tivnosti, a u krajnjoj levoj koloni sam unosi redne brojeve. 

Izgled dijaloškog prozora sa unetim jelima za doručak: 
 

 
 
Izgled dijaloškog prozora sa unetim jelima za sva tri obeda: 
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 Grupisanje jela po obedima 

Često se u radu javlja potreba da određene aktivnosti, zbog pregle-
dnosti, grupišemo u jednu ili više sumarnih aktivnosti.  

U našem primeru, jela pod rednim broje- 
vima 1 do 7 možemo grupisati u grupu „Do- 
ručak“, jela pod rednim brojevima 8 do 14 u 
grupu „Ručak“, a jela pod rednim brojevima 
15 do 21 u grupu „Večera“. To ćemo uraditi 
tako što ćemo označiti prvo jelo u nizu koji ho- 
ćemo da grupišemo (u ovom slučaju to bi b-
ilo jelo pod rednim brojem 1, desnim tast-
erom na redni broj 1 pa markiramo komandu 
New task). Iznad markiranog jela, pod re-
dnim brojem 1, dobićemo novi prazan red. U 
taj red upisujemo naziv naše sumarne akti-
vnosti (u ovom slučaju „Doručak“). 

Sada ćemo označiti sva pojedinačna jela (prevlačenjem kursora preko 
njihovih rednih brojeva) i podvesti ih pod sumarni naziv (koji se nalazi iznad 
njih) tako što ćemo kliknuti na ikonicu Indent – horizontalnu strelicu usmerenu 
nadesno.  

 

Primetićemo da je naziv sumarne aktivnosti sada ispisan podeblja-
nim slovima i da se ispred njega nalazi simbol - (crtica u kvadratiću). Ka-
da kliknemo na njega pojedinačne aktivnosti će se praktično podvući pod 
sumarnu aktivnost, a simbol - će se promeniti u +.  

Ovo možemo koristiti kada zbog preglednosti želimo da izbegnemo 
nepotrebnu detaljnost. 

Izgled sumarne aktivnosti „Doručak“ (sa prikazanim i „skrivenim“ poj-
edinačnim jelima) prikazan je na sledećim slikama: 
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Postupak je isti i za ručak i večeru. Pri tom ćemo dobiti sledeći pri-

kaz (sa „skrivenim“ pojedinačnim jelima): 

 
 
Uočavamo da se ispred grupnog naziva nalazi znak +, da je u koloni 

Duration program sam uneo vreme trajanja (sedam dana), kao i da je 
sam podesio vreme početka (Start) i završetka aktivnosti (Finish). Tako-
đe, na desnoj strani uočavamo novi grafički prikaz koji pokriva vreme tra-
janja aktivnosti – jelovnika. 

Ukoliko otkrijemo „skrivena“ pojedinačna jela (klikom levim tasterom miša 
na znak + ispred svakog grupnog naziva) po obedima dobićemo sledeći prikaz: 

 
Microsoft Office Project 2007 dozvoljava i niz drugih mogućnosti 

za pregledanje navedenih prikaza, kao što su npr. View – Calendar, 
View – Network Diagram, View – Tracking Gantt i drugi. 
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 Tako, na primer, u opciji View – Calendar možemo videti kompletan 

jelovnik po danima: 

 
U opciji View – Network Diagram možemo videti sledeći prikaz: 

 
U opciji View – Tracking Gantt možemo videti prikaz sa procentom 

realizacije: 

 
ili ukoliko je neki od jelovnika realizovan, prikaz će biti sledeći: 
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Unošenje resursa 
Program Microsoft Office Project 2007 obuhvata resurse – ljude i opre-

mu koji su potrebni da bi se završili određeni zadaci na nekom projektu. Micro-
soft Office Project 2007 usmerava svoje težište na dva aspekta resursa: nji-
hovu raspoloživost i njihove troškove. Raspoloživost određuje kada određeni 
resursi mogu da rade na zadacima i koliko posla mogu da obave, a troškovi se 
odnose na to koliko će novca biti potrebno za plaćanje tih resursa. Pored toga, 
MS project podržava i dva druga tipa specijalnih resursa: materijal i troškove. 

U ovom delu, kada je u pitanju naš primer, izvršićemo podešavanje i 
unošenje u projekat ljudskih i materijalnih resursa sa delom troškova. To će-
mo uraditi na sledeći način: otvorićemo naš projekat koji smo prethodno uradi-
li. Iz menija View izabraćemo opciju Resource Sheet. Koristićemo prikaz Re-
source Sheet da bismo lakše podesili početnu listu resursa za naš projekat.  

Otvoreni dijaloški okvir Resource Sheet:    

 

U prikazu Resource Sheet, u kolonu Resource name, upisujemo 
ime prvog radnika (u našem slučaju kuvara, s obzirom na to da ćemo kao 
ljudske resurse upotrebiti kuvare koji će spremati navedena jela). Nakon 
upisivanja prvog kuvara, pritiskom tastera „enter“ MS Project, pravi se 
novi resurs. Na isti način upisujemo i ostala imena. Kod svih imena u ko-
loni Type treba da bude obeležena opcija Work. U polje Max. Units uno-
se se podaci o zauzetosti osoblja (50%, 100%...). 

Napominjemo da se tabele Microsoft Office Projecta 2007 u velikoj 
meri ponašaju kao tabele Microsoft Office Excela 2007, odnosno pre-
vlačenjem podataka iz jednog okvira u drugi dolazi do njihovog kopiranja. 

Pošto smo uneli imena osoblja možemo uneti i troškove koje to osoblje 
iziskuje, odnosno odrediti njegovu cenu po satu-času rada. U prozoru Reso-
urce Sheet, u koloni Std. Rate, unosimo cenu po satu-času rada. 

Po unošenju ljudskih i troškovnih resursa unećemo u projekat i ma-
terijalne resurse. U našem slučaju unećemo podatke o potrebnim količi-
nama artikala hrane. 
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 Unošenje materijalnih resursa vršimo na sledeći način: u prikazu Re-

source Sheet, u kolonu Resource name u prvu sledeću slobodnu rubriku 
upisujemo naziv artikla hrane, a u koloni Type, u padajućem meniju, obe-
ležimo Material. U koloni Material Label unesemo količinu artikala hrane. 

Podaci koje smo uneli u dijaloški okvir Resource Sheet izgledaju ovako: 
 

 
 

Pored unetih podataka moguće je uneti i neke druge, kao npr. cenu 
artikala hrane, troškove prevoženja, itd. 

Na kraju, poslednje što ćemo uraditi u radu je da unete resurse 
dodelimo zadacima, odnosno pojedinačnim jelima. To ćemo uraditi na 
sledeći način: otvorimo naš projekt u opciji View – Gantt Chart, a zatim 
na paleti Tools odaberemo Assign Resources. 

Izgled palete Assign Resources prikazan je na sledećoj slici: 
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Na paleti Gantt Chart markiramo jelo kojem ćemo dodeliti resurse, a 
zatim iz tabele na paleti Assign Resources odaberemo resurse i klikne-
mo na dugme Assign. Kada iz date tabele odaberemo ime Žarko Žarko-
vić i kliknemo na dugme Assign, u samoj tabeli će se pojaviti i troškovni 
izdaci za navedeno lice za taj radni dan, što se vidi na sledećoj slici: 

 

Na isti način dodeljujemo i materijalne resurse, tako da na paleti As-
sign Resources imamo zbirne resurse za jedno jelo, kao što se vidi na 
sledećoj slici: 

 

Prikaz celog projekta „Izrada Plana dnevnih jelovnika“ pomoću pro-
gramskog paketa Microsoft Office Project 2007 (s napomenom da su 
resursi dodeljeni samo jelima za doručak), u dijaloškom okviru Gantt 
Chart izgleda ovako:  
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Mogućnosti praktične primene 
izrađenog projekta 

Mogućnosti primene izrađenog projekta su velike i značajne, a koliko 
će biti iskorišćenje zavisi od znanja i umešnosti korisnika. U ovom delu 
iznećemo samo nekoliko primera koji pokazuju na koji način se projekat 
može koristiti i koje nam sve podatke može pružiti. 

Pokazatelji ostvarene vrednosti plana 
Da bismo videli ove pokazatelje potrebno je otvoriti urađeni projekat u 

dijaloškom okviru Gantt Chart, a zatim na paleti View odabrati: More Views 
– Task Sheet i zatim pritisnuti dugme Apply. Dobićemo sledeći prikaz: 

 
Uočavamo: u koloni EAC (estimate at completion) trošak za svako 

jelo je 1.600,00 dinara (u delu obrađenom u podnaslovu 7.2.2 – unošenje 
resursa, svakom angažovanom licu odredili smo cenu angažovanja po 
200,00 dinara za sat rada, što za osam sati iznosi 1.600,00 dinara. Odre-
dili smo da svako jelo priprema jedno lice). Na rednom broju 1 – Doručak 
uočavamo 11.200,00 dinara, što je zbir svih 7 dana po 1.600,00 dinara. 
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Vizuelni izveštaj ostvarene vrednosti 

Da bismo izradili vizuelni izveštaj ostvarene vrednosti potrebno je u 
meniju Report izabrati Visual Reports, a zatim otvoriti karticu Assig-
nment Usage i izabrati Earned Value Over Time Report. Dobićemo 
sledeći prikaz: 

 
 
U polju Select level of usage data to include in the report izaberemo 

interval u kojem želimo da napravimo izveštaj, a zatim izaberemo opciju Vi-
ew. Otvoriće se prozor Microsoft Office Excel. Izabraćemo stranu Assig-
nment Usage withEV i na desnoj strani na paleti Pivot Table Field List 
markirati opciju Cumulative Cost (ostale po potrebi). Dobićemo tabelu: 
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 U tabeli vidimo ukupne troškove. Ako odaberemo list Chart 1 može-

mo videti i grafički prikaz: 

 
 
Program nudi i niz drugih mogućnosti prikaza koje nam mogu biti od 

koristi za praćenje poslovanja, troškova i realizacije zadataka. Možemo ih 
pronaći aktiviranjem opcije Report na osnovnoj paleti menija, a zatim 
odabirom opcije Reports, čime ćemo dobiti poseban dijaloški okvir u ko-
jem možemo odabrati neki od ponuđenih načina vizuelnog prikaza poda-
taka. 
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Zaključak  
Mogućnosti programskog paketa Microsoft Office Project 2007 svaka-

ko su velike i još uvek nedovoljno prihvaćene. Takođe, ovaj programski pa-
ket, zbog sklonosti da se teško menja nešto na šta smo navikli, nije našao 
adekvatnu primenu u praksi. Upravljanje projektima je, u stvari, široko prime-
njena veština i nauka, a osnovni cilj upravljanja projektima jeste da se pruži 
pomoć u planiranju i kontrolisanju realizacije aktivnosti koje se preduzimaju. 

U radu su prikazane mogućnosti korišćenja programskog paketa 
Microsoft Office Project 2007 u planiranju, organizovanju i realizaciji is-
hrane pripadnika Vojske, sa konkretnim primerom simulacije izrade Pla-
na dnevnih jelovnika. Prikazan je način planiranja jelovnika i dodeljivanja 
ljudskih i materijalnih resursa svakom od planiranih jela, a navedeni pro-
gramski paket pruža korisnicima i niz drugih mogućnosti kojima se mogu 
dobiti veoma bitni podaci za dalji rad.  

Cilj primene ovog programskog paketa u realizaciji ishrane pripadni-
ka Vojske jeste da se dobiju najpovoljnija rešenja za ishranu sa stanoviš-
ta mogućnosti i potreba, kao i da se skrati vreme izrade planova i drugih 
dokumenata bitnih za planiranje i organizovanje ishrane. Sadašnji način 
rada, osim što oduzima mnogo vremena, nije konzistentan i ne daje ni 
dovoljno podataka niti oni stižu na vreme, a moramo ih imati pri donoše-
nju odluke o načinu organizovanja ishrane, o izradi plana dnevnih jelovni-
ka, odnosno odabiru jela i zadovoljenju propisanih kriterijuma. Pored to-
ga, primenom ovog programskog paketa mogu se ostvariti i uštede na ra-
znim poljima i obezbediti povećanje efikasnosti rada. 
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APPLICATION OF THE MICROSOFT OFFICE PROJECT 2007 FOR 
PLANNING THE ARMY PERSONNEL FEEDING PROCESS 
 
Summary: 

This paper presents the use of the Microsoft Office Project 2007 as a 
project management application for planning the feeding process in the 
Army. In order to have an appropriate and efficient feeding process of the 
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 military personnel the implementation of decision making techniques is an 

imperative.  Application of these techniques in planning and organizing 
meal preparation for the military personnel would produce many savings 
regarding food supplies, transportation means, labour, equipment, and re-
duce the time for food preparation and budget spending, as well. In this 
paper only some of possibilities which the Microsoft Office Project 2007 
could offer for management of projects are presented. 

Introduction  

Employing this software as a planning support would largely con-
tribute to more efficient and more organized planning of feeding pro-
cess system, as well as planning of other organized systems important 
for functioning of one mega-system such as the Army of Serbia.  

Decision-making in a given situation depends on the evaluation of all 
circumstances which can affect execution of the process, but also on proper 
management which is essential considering that many factors affect the rea-
lisation of the process and inevitably change parameters of business. The 
Microsoft Office Project 2007 is irreplaceable help in such situations- it 
provides a possibility to the user to be ahead of the circumstances.  

MANAGING THE PROJECTS WITH THE MICROSOFT OFFICE 
PROJECT 2007  

Managing the projects depends on time limits, budget and effort 
invested in their completing. In order to realize a project successfully, 
we have to coordinate all mentioned factors, and the easiest way to ac-
hieve that is by using a software package for project managing such as 
the Microsoft Office Project 2007.  

MS Project Accounts (Displays)  

The MS Project contains large number of accounts used for entering, 
editing, analyzing and showing project information. Some of the most signi-
ficant and the most often used accounts are: Gantt Chart, Resource She-
et, Task Sheet, Resource Usage, Task Usage and Network Diagram.  
Saving and protection of MS Project  

A project plan done in MS Project can be saved as files in any ot-
her Microsoft applications, using the option Save As. Saving and pro-
tection of MS Project can be achieved by using the option : Save As-> 
Tools-> General Options-> Save Options and entering the password 
in Protection Password field.  

Setting the basic program information  

Prior to the start, it is necessary to set the basic information in the 
dialog frame Project Information (Project-> Project Information). 
Project information is entered in eight available fields: Start Date, Fi-
nish Date, Schedule From, Current Date, Status Date, Calendar, 
Priority and Enterprise Custom Fields.  
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Setting the basic activity information  

In order to change the settings related to the type of activity, dura-
tion, etc., using the option Tools-> Options -> Schedule is necessary. 
It is possible to choose in this dialog frame if the start date of activity is 
the same as the date of the beginning of the project, or a current date, 
which means that it is possible to choose a unit where the duration of 
activity and work will be entered.  

PLANING THE DAILY MENUS USING THE MICROSOFT OFFICE 
PROJECT 2007  

This part of the paper presents one of many possibilities of the 
application of the program package Microsoft Office Project 2007. 
The application of this program package for planning, organizing and 
realization of the meal preparation for Army personnel  would conside-
rably make the work easier for people executing this task, especially 
for immediate realizers – managers of military restaurants. After instal-
ling the program package and setting the basic information, names of 
the courses are entered, and the program appoints the beginning and 
the end of activity (or we can do that ourselves).  

Grouping the courses in meals  

The courses – activities are grouped in order to be easy-to-survey. 
They can be grouped in one or more summary activities. In our example 
courses are grouped in meals: “Breakfast”, “Lunch” and “Dinner”. Grou-
ping is done by activating the command New Task (new line appears, 
where we type the name of summary activity, for example “Breakfast”) 
and Indent (courses that we want to group are previously marked).  

Entering the resources  

Resources comprise people and equipment essential for fulfillment of 
the specific project tasks. In this case focus is on the two aspects of resour-
ces: their availability and their costs. Availability determines when specific 
resources can work on assignments and how much they can do, while 
costs refer to how much money will be needed for paying these resources. 
Besides that, MS Project supports two other types of special resources: 
material and costs. This example shows setting and entering into the project 
human and material resources with part of their costs. Entering the resour-
ces is done by choosing the option Resource Sheet from the menu View.  

Possibilities of practical application of designed project  

Possibilities of application of designed project are large and signi-
ficant, and they depend on knowledge and adroitness of the user. The 
main purpose of the designed project is helping with the decision-ma-
king based on the shown facts which directly affect bringing these deci-
sions. The program package Microsoft Office Project 2007 is actually 
a support system for decision-making on all its levels.  
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 Indicators of achieved plan value  

Proper application of designed project eases the insight to all 
kinds of expenses which are inevitable in realization of planned activiti-
es. It is up to us to make these expenses economically justified.  

Visual report of achieved values  

This program offers a range of possibilities of displays which can 
be useful for monitoring the business, expenses and task realization. 
We can find them by activating the option Report in the basic menu, 
and then choosing the option Reports to open a dialog frame where 
we can choose some of the offered ways to show data visually.  

CONCLUSION  

This paper presents possibilities of using the program realisation 
of feeding process of the Army personnel with simulation of planning 
the daily menus as a concrete example. It presents the way of planning 
the menus and adding the human and material resources to each of 
planned courses. This program package also provides a range of other 
possibilities to users, which can produce savings in different fields and 
secure increase of work efficiency.  

Key words: Microsoft Office Project 2007, program, planning, manage-
ment, resources, feeding, menu.  
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